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SECTION 1.  STUDENT TRAINING MATERIAL GENERAL OVERVIEW.  Section one of the 
Student Training Material General Overview provides information about the Communications Support 
Processor (CSP) training course. 
 
1.1  Purpose.  The Student Training Material General Overview for the CSP provides an introduction for 
technical operators, high-level managers, or any other interested individuals to the functions and 
capabilities of the CSP system.  Course information for the Computer Operations, Message Clerk 
Functions, System Manager Functions, and Security Manager Functions in-house training program is 
provided within this document.  In addition to providing general information about the capabilities of the 
CSP system, this document introduces the course information for the course that is conducted at the 
contractor's facility. 
 
1.2  Course Objectives.  The Student Training Material General Overview objectives are to provide an 
outline for each section of the in-house training course, and to introduce the basic and resource 
operations of the CSP system that are common to the training course.  The general overview ends with 
specific information that introduces the student to the CSP system and window terminology, basic 
operations, and resource operations.  The general overview provides the student with information about 
the CSP as an indoctrination to the training program.  The general overview also provides high-level 
management personnel with an insight into the overall in-house training program. 
 
1.3  Specific Course Information.  Each student should possess at least a SECRET clearance to attend 
the in-house training course. 
 
The in-house training program is conducted at the contractor's facility.  The course is comprised of a 
General Overview, Computer Operations, Message Clerk Functions, System Manager Functions, and 
Security Manager Functions.  There are no special evaluations or grades assigned to the students who 
attend the CSP in-house training course. 
 
1.3.1  Required Publications.  The following publications are required for the CSP training course: 
 
CSPM-5.8-SUM, Software User's Manual for the Communications Support Processor 
 
10-5.7-TCO, Student Training Material Computer Operations for the Communications Support Processor 
 
CSPM-5.8-TGO, Student Training Material General Overview for the Communications Support 
Processor 
 
10-5.7-TMC, Student Training Material Message Clerk Functions for the Communications Support 
Processor 
 
CSPM-5.8-TSE, Student Training Material System and Security Manager Functions for the 
Communications Support Processor 
 
CSPM-5.8-CIG, Configuration and Installation Guide for the Communications Support Processor 
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1.3.2  Reference Publications.  The following Department of Defense (DoD) and CSP documents are 
considered general reference materials for the CSP training course: 
 
1.3.2.1  DoD Reference Publications.  The following documents are considered general reference 
materials for the CSP training course: 
 

DOI-103, Defense Special Security Communications System (DSSCS) Operating Instructions 
(U), CONFIDENTIAL 

 
JANAP 128 (J), Automatic Digital Network (AUTODIN) Operating Procedures JANAP 128 (J) 

 
1.3.2.2  CSP Reference Publications.  The following documents are considered general reference 
materials for the CSP training course: 
 

CSPM-5.8-VDD, Version Description Document for the Communications Support Processor 
 
CSPM-5.8-ICD, Interface Control Document for the Communications Support Processor 
 
CMI-3.2-ICD, Interface Control Document for the Communications Support Processor Message 
Interface 

 
1.4  Training Facilities.  Sterling Software offers the CSP training course at its Bellevue facilities.  The 
training facility is comprised of three separate areas: a classroom, a computer room, and a training room 
where the students receive an opportunity for hands-on experience. 
 
When combined with classroom discussions, the slides provide the students with the information 
required to fully operate a CSP system.  Each of the commands and functions discussed in the classroom 
can be executed to see how the system actually reacts.  The students solve problems similar to those that 
may be encountered in the field. 
 
1.5  Scope.  The training course materials are developed from the Training Course Outline for Computer 
Operations and Message Clerk Functions and the Training Course Outline for System Manager and 
Security Manager Functions.  These outlines represent the division of each of the major units of 
instruction into topics and subtopics.  The topics and subtopics for the training course and the general 
overview are discussed in the following paragraphs. 
 
1.5.1  General Overview.  The following outline provides the topics and subtopics covered in this 
portion of the CSP training course: 
 

a. Introduction to CSP 
 

1. Mission, Functionality, and Subsystems 
2. Graphical User Interface (GUI) 
3. Hardware Configuration 
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b. Basic Operations 
 

1. System Identification (ID) and Login 
2. Notice Window 
3. Help 
4. Password 
5. Session Exit 

 
c. Resource Operations 

 
1. Database Operations  
2. Parameter Operations 
3. Resource Contention 

 
1.5.2  Computer Operations.  The following outline provides the topics and subtopics covered in this 
portion of the CSP training course: 
 

a. Specifics of Computer Operations 
 

1. Acronyms and Terms 
2. Disk Utilization 
3. System Power-Up 
4. System Boot/Reboot 
 

 b. Functions 
 

1. Status 
2. Control 
3. Report Generation 

 
1.5.3  Message Clerk Functions.  The following outline provides the topics and subtopics covered in 
this portion of the CSP training course: 
 

a. Specific Message Clerk Functions 
 

1. Acronyms and Terms 
 
b. Functions 

 
1. Message Review 
2. Message Recall 
3. Message Generation 
4. Message Section Processing 
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1.5.4  System Manager Functions.  The following outline provides the topics and subtopics covered in 
this portion of the CSP training course: 
 

a. Specific System Manager Functions 
 

1. Acronyms and Terms 
 

b. Functions 
 

1. Databases 
2. Parameters 
3. System Utilities 
4. On-Line Testing (OLT) 

 
c. Software Release Procedures 

 
1. Release Information 
2. Site Configuration Options 
3. Installation Procedures 
4. Update Procedures 
5. Database Update/Configuration 

 
1.5.5  Security Manager Functions.  The following outline provides the topics and subtopics covered in 
this portion of the CSP training course: 
 

a. Specific Security Manager Functions 
 

1. Acronyms and Terms 
   

b. Functions 
 

1. User Access 
2. Security Dictionary 
3. Communication Lines 
4. Information Labels 
5. Audit Trail 
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SECTION 2.  COMMON CSP INFORMATION 
 
Section two of the Student Training Material General Overview provides introductory information for the 
CSP training course.  This information details CSP acronyms, window terms, basic operations, and 
resource operations. 
 
2.1  Acronyms and Terms. 
 
2.1.1  Window Terms.  The following are window terms used throughout this document: 
 

active window The window that is currently receiving keyboard input. 
 

check box An object that represents a true or false state for a data item. 
 

classification bar Located just below the title bar and around the perimeter of the 
window just inside the border.  Denotes the security 
classification of the data displayed in a window through color 
and labeling. 

 
context-sensitive help Provides help for a specific pull-down menu name or pull-down 

menu option. 
 

dialog A rectangular region similar to a window, that allows a limited 
interaction to take place between the application and the user. 

 
drag Press and hold the select button on the mouse, move the pointer, 

and release. 
 

focus Determines which object receives keyboard input. 
 

Help window A separate window used to display help text. 
 

icon A small square containing a picture and an abbreviated label 
identifying the application. 

 
Icons window A special window at the bottom of the screen where icons are 

displayed in rows and columns. 
 

keyboard An input device allowing entry of text and an alternative to 
using a mouse. 

 
list An object that displays application-specific data items in a 

vertical format. 
 

maximize button A button located to the right of the minimize button at the upper 
right corner of the window that is used to maximize a window. 

 
maximized A window that has been enlarged to fill the entire screen. 
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menu bar A rectangle that contains the names of one or more pull-down 
menus organized horizontally. 

 
minimize button A button located just to the right of the title bar used to 

minimize a window. 
 

minimized A window that is enclosed in an icon. 
 

mouse An input device whose movement on the work surface is 
reflected by the movement of the pointer on the screen. 

 
pane A single text area within a paned area. 
 
pull-down menu A menu that is "pulled down" from the menu bar. 

 
push The act of selecting a button with either the mouse or the 

keyboard. 
 

push button A rectangular object that appears raised through the use of three 
dimensional shadowing.  The object contains a label that 
indicates the action to be taken when the button is pushed. 

 
resize Changes the size of a window in any direction. 

 
radio box A rectangular area that encloses two or more radio buttons. 

 
sash A small square positioned at the far right end of the horizontal 

lines separating a paned area.  Moving the sash up or down 
adjusts the vertical size of the two adjacent panes. 

 
scale A rectangular object containing a slider in a trough. The scale is 

used to select a numeric value for a data item from a range of 
values. 

 
scroll bar A rectangular object located along the right edge of a list or text 

area.  The object contains a slider in a trough, and is used to 
scroll through a list. 

 
select button The left button on the mouse. 

 
select Choose an object in a window using the mouse or keyboard. 

 
slider The lighter raised rectangle contained within the trough. 

 
stepper An object consisting of two arrow buttons and a rectangle.  The 

stepper is used to set a numeric value for a data item from a 
limited set of possible values. 

 
text An object that allows free-format alphanumeric data to be 

displayed and/or edited. 
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title bar A bar across the top of a window containing the name of the 

associated application. 
 

window A rectangular area that encloses the tools and data associated 
with each CSP application. 

 
window menu button A button located at the upper left corner of the window that is 

used to select the Window menu. 
 
2.1.2  CSP Specific Acronyms.  The following are CSP acronyms used throughout this document: 
 

ACP Allied Communications Publication 
 

ACTP Accreditation/Certification Test Plan and Procedures 
 

AMPE Automated Message Processing Exchange 
 

AUTODIN Automatic Digital Network 
 

BCC Base Communications Center 
 

CAI Communications Action Identifier 
 

CIC Content Indicator Code 
 

CPU Central Processing Unit 
 

CRC Cyclic Redundancy Check 
 

CRITIC Critical Intelligence 
 

CSP Communications Support Processor 
 

DCA Defense Communications Agency 
 

DDCMP Digital Data Communications Message Protocol 
 

DEC Digital Equipment Corporation (now Compaq) 
 

DIA Defense Intelligence Agency 
 

DoD Department of Defense 
 

DOI DSSCS Operating Instruction 
 

DSSCS Defense Special Security Communications System 
 

DTG Date-Time Group 
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EFTO Encrypt for Transmission Only 

 
GENSER General Service 

 
GUI Graphical User Interface 

 
HDLC High-Level Data Link Control 

 
ID Identification 

 
JANAP Joint Army Navy Air Force Publication 

 
LAN Local Area Network 

 
LMF Language Media Format 

 
MSP Message Section Processor 

 
OLT On-Line Testing 

 
OSF Open Software Foundation 

 
OSRI Originating Station Routing Indicator 

 
PLA Plain Language Address 

 
RI Routing Indicator 

 
RLS Routing Line Segregation 

 
SCI Sensitive Compartmented Information 

 
SHD Special Handling Designator 

 
SPECAT Special Category 

 
SSN Station Serial Number 

 
SSO Special Security Office 

 
SSTP System Software Test Plan 

 
SUM Software User's Manual 

 
TCC (1)  Telecommunications Center 

(2)  Transmission Control Code 
 

TCP/IP Transmission Control Protocol/Internet Protocol 
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TRC Transmission Release Code 
 

VAX Virtual Address Extension 
 
2.2  Introduction to CSP.  The introduction to CSP is designed to provide the student with a basic level 
of understanding about the CSP system.  This understanding includes the CSP's mission, functionality, 
subsystems, hardware configuration, GUI, basic operations, resource operations, file menu, options 
menu, and parameter operations (Slide 2-1). 
 
2.2.1  Mission, Functionality, and Subsystems.  A description of the overall capabilities of the CSP is 
broken down into three main areas.  These three areas are the mission, functionality, and subsystems. 
 
2.2.1.1  Mission.  The purpose of the CSP is to automate the activities of a fixed-base SSO 
Telecommunications Center (TCC) and/or Base Communications Center (BCC).  Its goal is to reduce or 
eliminate labor-intensive activities that are normally associated with the TCC. 
 
The CSP is capable of handling both Defense Special Security Communications System (DSSCS) and 
General Service (GENSER) message traffic simultaneously.  In addition, the CSP is tailorable to satisfy 
tactical/mobile communications requirements.  In the security arena, the CSP satisfies the requirements 
for an Automated Message Processing Exchange (AMPE) listed in Defense Intelligence Agency (DIA) 
Circular 5030.58-M.  The CSP also satisfies Defense Communications Agency (DCA) Circulars 370-
D195-1 and 370-D195-3 for its connection to the AUTODIN (Slide 2-2). 
 
2.2.1.2  Functionality.  The CSP is primarily a store and forward communications processor.  Each 
message that enters the system is normally delivered to one or more destinations.  The CSP is also 
capable of serving as a front-end to a variety of backside computer systems.  In this mode, the CSP 
provides an interface to the AUTODIN network and also provides DD Form 173/ACP 126 format 
conversion.  The succeeding paragraphs discuss the primary functions provided by the CSP (Slide 2-3): 
 

a. Communication circuit automation - The CSP provides the operator with the capability 
to turn each of the communication lines on or off.  Once a line has been turned on, the 
line functions without further operator action.  All message transfers and protocol 
handshaking is done automatically by the communications software.  A line that is 
temporarily suspended resumes by itself when the distant end is back on-line. 

 
b. Message receipt - Each receive line within the CSP is responsible for receiving messages 

from its connected system and for redundantly storing these messages in their entirety on 
the message file.  When selected, a Cyclic Redundancy Check (CRC) is performed on 
the  messages as they are received to ensure message accuracy.  Messages that fail CRC 
checking are rejected to the sender (with the exception of AUTODIN). 

 
c. DD Form 173/ACP 126 conversion - The CSP is capable of receiving DD Form 173 

messages from backside systems.  These messages are then converted to Joint Army 
Navy Air Force Publication (JANAP) 128, DSSCS Operating Instruction (DOI)-103, 
DOI-103 modified messages, or Allied Communications Publication (ACP) 126.  The 
final message format is based on the Plain Language Addresses (PLAs), the message 
precedence within the original DD Form 173 message, and message processing 
parameters. 
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The CSP is also capable of converting ACP 126 messages to JANAP 128 messages.  It is 
possible to designate up to four RIs, which initiate CSP’s conversion from ACP 126 to 
JANAP 128 format. 

 
d. Message format validation - Each message that enters the system undergoes format 

validation to ensure that it conforms to all of the standards required by the given message 
format.  The CSP supports the following formats: 

 
JANAP 128 narrative 
JANAP 128 data pattern (card and variable length formats) 
ACP 127 narrative 
ACP 127 state 
DOI-103 narrative 
DOI-103M narrative 
DOI-103 data pattern (card format) 
ACP 126 
 

Some of the fields that are validated are precedence, Language Media Format (LMF), 
classification, Content Indicator Code (CIC)/Communications Action Identifier (CAI), 
Originating Station Routing Indicator (OSRI), Station Serial Number (SSN), file time, 
Transmission Release Code (TRC), Transmission Control Code (TCC), destination 
Routing Indicators (RIs), and Date-Time Group (DTG).  All required format lines are 
also verified to be present.  Messages with format errors are sent to a service position for 
operator action. 

 
e. Message security validation - Each message that enters or exits the system is checked to 

ensure the communication line passing the message is authorized to process the security 
words contained within the message.  This includes classifications, compartments, 
codewords, caveats, handling instructions, TCCs, Special Categories (SPECATs)/Special 
Handling Designators (SHDs), LMFs, and special words/phrases.  Each communication 
line has its own configurable set of criteria used for validation.  Messages with security 
errors are sent to the service position for operator disposition. 

 
f. Automated message routing determination - Each message that passes through the system 

is processed by the automatic routing process.  When the system is configured, an 
automatic routing database is built consisting of routing criteria.  The automatic routing 
process scans the message and assigns organization(s) and office symbol(s) routing 
based on message text and the database.  The message can be automatically routed to the 
destination(s) associated with the assigned office symbol(s) or forced to the message 
clerk position for final review. 

 
g. Manual dissemination - Manual routing is a function performed at a user terminal that 

allows the message clerk to assign routing distribution on a message.  While reviewing a 
message on a distribution destination, the clerk may inspect the message for routing 
criteria, assign or remove organizations and office symbols, and assign the number of 
copies required for each office symbol.  After assigning the desired dissemination, the 
clerk may release the message for distribution.  This places the message on the output 
destination(s) associated with the assigned organization(s) and office symbol(s). 
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h. Message generation - Message generation is a function performed at a user terminal that 
allows messages to be prepared from scratch or by selecting one of the templates and 
changing the appropriate fields.  Generation capabilities may be used for generating 
service messages, fully formatted message traffic, or DD Form 173 messages for later 
conversion.  A newly generated message that enters the system is subjected to the same 
format and security checks as if it were received from an external line. 

 
i. Message edit - Message edit allows messages contained on a review destination to be 

modified at a user terminal.  Once editing is completed, the message may be reentered 
into the system as a modified message or as a completely new message with no history of 
the original.  It may also be saved as a template for later use in the message generation 
function. 

 
j. Message transmission - Each transmit line within the CSP is responsible for transmitting 

all messages that are placed on its associated processing destination.  Each message 
undergoes security validation before it is transmitted to ensure it is authorized to be 
transmitted on that line.  When selected, CRC is performed on the message to ensure the 
message is accurately read from the message file and to provide a means of validation at 
the distant end.  Messages failing the security check or CRC validation are sent to a 
service position for operator action as are those that are rejected by the distant end. 

 
k. Message recall - The CSP provides the operator with the capability to recover any 

message received into the system.  Messages may be recalled individually or by a group 
defined by given parameters.  Recalled messages may be placed on the recall destination 
or any destination that originally received the messages.  Messages placed on the recall 
destination may be reviewed, deleted, saved as templates, or modified and sent into the 
CSP system as a new message. 

 
In addition to the above primary functions, the CSP has a number of support functions used to configure 
and control the system as well as to provide status information.  These functions are discussed in the 
following paragraphs: 
 

l. On-line system configuration control - The CSP System Manager is provided with the 
means to configure the system while it is on-line.  This includes the ability to modify the 
following databases: 

 
automatic routing 
office assignments 
PLA 
RI 
Routing Line Segregation (RLS) 
Destinations 
STU III 

 
The System Manager is allowed to configure the automatic routing scanning parameters, 
the message file and archive disks, the report generation parameters, message processing 
parameters, font characteristics, CDAC parameters (if configured), and the precedence 
timers.  The System Manager is also allowed to configure the communication lines in  
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regards to destination, channel identifier, channel number, maximum message size, 
format conversions, line characteristic options, supplemental data options, and line 
protocol information.  Although considered to be support functions, these utilities are 
quite powerful and can have a major impact on the system. 

 
m. System control - This functionality is supported through a variety of utilities.  The 

system disk utilities allow the system operator to mount, dismount, and initialize disks.  
The disk utility also provides the capability to make a complete backup of the system 
disk.  The tape utilities allow the system operator to initialize tapes, backup CSP data 
files to tape, restore CSP data files from tape, and verify message traffic written to tape.  
The communication lines control application allows the operator to turn selected 
communication lines on or off.  The operator is also allowed to establish or cancel 
alternate routing for each destination.  Alternate routing may be selectively established 
by precedence, and may be further restricted by RI if desired.  A message processing 
application allows the system operator to enable or disable system-wide message 
processing or message archiving.  The system operator also has the ability to establish 
and cancel STU III connections.  Another application allows the system operator to 
perform a controlled system shutdown or to reboot the entire system.  The ability to 
perform each of these applications is controlled by each operator's privileges.  Thus, only 
a select group of individuals is allowed to affect system performance. 

 
n. Status reporting - The CSP provides the current operations status in five windows 

accessible by the user.  One window provides the communication lines status (on/off 
state, number of messages processed, et cetera).  A second window provides the message 
routing status for each destination in the system.  A third window provides message 
processing statistics such as what storage devices are configured, the system date and 
time, and the number of messages currently contained in the CSP system.  The fourth 
window describes the AUTODIN interface in regards to what control sequences have 
been processed and the current line efficiency percentages.  The fifth window reports the 
STU III Status (enabled or disabled).  The CSP also provides a number of hard copy 
reports.  These reports include PLA usage, group PLA usage, unknown PLA usage, 
hardware configuration, line message logs, line statistics, routing statistics, and intercept 
statistics.  These reports can be previewed before printing. 

 
o. OLT support - An automated testing application is available to read in messages to the 

CSP.  This application allows users to test various aspects of the system with baseline 
test messages.  The test messages need to be set up with the proper site specific 
information (i.e., RIs, PLAs, et cetera) before the site uses the messages to test the CSP 
system.  These messages are prepared at the user's discretion.  The test procedures to be 
performed and the expected results for the Accreditation/Certification Test Plan and 
Procedures (ACTP) and System Software Test Plan (SSTP) are provided in order to 
verify that the system is operating properly.  Testing is divided into three areas: 
accreditation/certification, system software, and free form.  Free form testing does not 
have any set procedures or test messages.  Its main purpose is to allow site-specific 
testing that may be used in problem solving. 

 



CSPM-5.8-TGO-24APR02 
 

 13 

p. User Access Privileges - The CSP Security Manager is provided with the means to assign 
specific access privileges to each person that operates the CSP system.  These privileges 
determine the menu options presented to each CSP operator.  Each CSP application may 
or may not be assigned individually to each user.  In addition, View or Modify access 
may be assigned when database privileges are assigned. 

 
2.2.1.3  Subsystems.  The overall CSP functionality is divided into five distinct subsystems (Slide 2-4).  
The communications subsystem is responsible for all message traffic being received or transmitted by the 
CSP system.  It also controls access to all peripheral devices in regards to message traffic.  The 
processing subsystem performs all of the message validation, ARM processing, DD Form 173 
conversion, and ACP 126 to JANAP 128 conversion.  The host subsystem is the main controller of the 
entire system.  It maintains all of the message destinations and various system statuses.  It controls access 
to the message files and the archives, as well as all processing dealing with sectioned messages.  The 
fourth subsystem is the storage subsystem.  It is ultimately responsible for all data stored on any of the 
disk media.  Finally, the user interface subsystem is responsible for communications with the user 
terminals.  Each window displayed on a user terminal is monitored and controlled by this software. 
 
2.2.1.3.1  Communications.  The communications subsystem controls all message traffic flow between 
CSP and non-CSP communication systems (Slide 2-5).  Its main function is to exchange traffic with these 
external systems, via Communications Interface Devices, using one of the following protocols:  Mode I, 
Mode II, Digital Data Communications Message Protocol (DDCMP), High-Level Data Link Control 
(HDLC), or Transmission Control Protocol/Internet Protocol (TCP/IP).  In addition, this subsystem 
supports all message traffic on magnetic tape.  These magnetic tapes may be from or for other computers 
systems outside of the TCC or for those who are not electronically connected to the CSP.  Delivery of 
message traffic to printers is controlled by the communications subsystem as is the handling of intercept 
traffic.  When a message's original destination is unreachable for any length of time, messages may be 
intercepted or stored to a temporary storage device.  Once the destination is reachable again, all 
intercepted traffic is read from the temporary storage device and placed back on the original destination 
for delivery.  The on-line testing software is also part of this subsystem and it controls the entry of test 
messages into the system. 
 
The communications subsystem is heavily dependent on the storage subsystem.  All message traffic 
received is stored on the message files and traffic to be transmitted is retrieved from the message files.  
All of the test messages for the OLT software are stored on the system disk.  All of the databases that 
define the characteristics of each of the communication lines are also stored on the system disk.  This 
includes the communication lines parameters database, the security dictionary, and the communication 
lines security database.  The communications subsystem also communicates with the host subsystem in 
order to retrieve messages from the destinations and to accept line control commands. 
 
2.2.1.3.2  Processing.  The processing subsystem is responsible for all internal message processing (Slide 
2-6).  All messages received into the system undergo format validation and security validation.  Messages 
with errors are sent to the service position for operator action. 
 
Once a message has been validated, it is passed to the automatic routing process.  Here, each message is 
scanned for key phrases used to route the message to designated destinations.  Each phrase found results 
in a group of organization(s) and office symbol(s) being added to the message dissemination list.  Once 
the message has completed the automatic routing process, it is delivered to the destination(s) associated 
with each of the office symbols in the dissemination list.  If a message is unable to be successfully 
routed, it is delivered to a distribution position for message clerk action. 
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The processing subsystem is also responsible for converting all DD Form 173 messages.  Depending on 
the PLAs used in the message, the DD Form 173 message is converted into a GENSER (JANAP 128 or 
ACP 126) message or into a DSSCS (DOI-103) message.  If the message is a Critical Intelligence 
(CRITIC), then it is converted into a DOI-103 modified message.  The PLA-to-RI associations are 
defined in the PLA database located on the system disk. 
 
The processing subsystem accesses many of the databases stored on the system disk.  These include the 
security dictionary, the communication lines security database, the PLA databases, the automatic routing 
database, and the office symbols database.  It also records many of the system statistics used in the 
reports generated by the system operators.  The message files are accessed to retrieve messages and to 
store message characteristics information.  The destinations controlled by the host subsystem are 
accessed in order to retrieve messages to process or to route messages to their destinations. 
 
2.2.1.3.3  Host.  The host subsystem is responsible for controlling all message flow within the system 
(Slide 2-7).  This includes all queuing and dequeueing of messages on the system destinations.  It is also 
responsible for tracking all status information in the system in regards to destinations, communication 
lines, AUTODIN, and storage devices.  It stores all message descriptors, supplemental data, and text on 
the message files and retrieves this information for other uses.  Once a message has completed 
processing, the host subsystem prepares the message for storage on the archive disk.  All auditable events 
are stored for historical purposes and may be retrieved for operator review. 
 
The host subsystem acts as a utilities server for disks and tapes.  It is responsible for initializing disks and 
tapes and for mounting and dismounting disks.  It also allows the System Manager to make a complete 
backup of the system disk.  This is effectively a disk-to-disk copy.  The tape utility also provides a 
backup function; however, only a select group of the CSP data files are copied to tape.  These files may 
later be restored from the tape back onto the system disk.  Finally, the tape utility verifies message traffic 
on magnetic tape by checking the classification and format of each message on the tape and printing a 
header/trailer log report. 
 
Another aspect of the host subsystem is the Message Section Processor (MSP).  This software is 
responsible for processing all sectioned messages that require concatenation before final delivery to a 
destination.  Sectioned messages are grouped together according to OSRI, DTG, precedence, 
classification, and expected section total.  Each message section can be released individually or an entire 
group can be released.  The sections may be reviewed, combined with other groups, or separated into 
new groups.  The MSP may only be accessed by one user terminal at any one time. 
 
2.2.1.3.4  Storage.  The storage subsystem is responsible for writing and reading all storage devices 
(Slide 2-8).  Each message that enters the system is redundantly stored on the message files.  All 
processing information pertaining to the message is also stored on the message files.  Once a message has 
been delivered to all of its intended destinations, it becomes inactive and is marked as requiring 
archiving.  When archiving is enabled, all messages requiring archiving are transferred to an on-line 
archive disk.  An audit trail of events is stored on the system disk and may also be moved to an archive 
disk.  Each archive disk is capable of storing many days worth of traffic.  In addition to the on-line 
message archive, all of the previous archive disks are maintained in a disk library and may be used in the 
off-line mode to recall older information.  This disk library provides a history for months or years, 
depending on disk availability and site throughput. 
 



CSPM-5.8-TGO-24APR02 
 

 15 

2.2.1.3.5  User Interface.  The user interface subsystem is composed of all software used to 
communicate with or operate the user terminals (Slide 2-9). The user interface to the system is 
accomplished using the X Window System and following Open Software Foundation (OSF)/Motif 
standards.  The user terminals are color terminals interfaced to the CSP via an Ethernet Local Area 
Network (LAN).  There are no disks on the user terminals.  User terminal software is downloaded from 
the host. The user interface subsystem passes all requests for information and all commands to the host 
subsystem that performs the actual work. 
 
2.2.2  Graphical User Interface.  All access to the CSP is accomplished via the user terminal (Slide 
2-10).  The CSP window environment employs the OSF/Motif GUI (an extension to the X Window 
System).  Color-coded classification bars are used to reflect the level of security of the information 
within each window.  The following classification/color associations are used within the system: 
 

Unclassified - Green 
 
Unclassified Encrypt for Transmission Only (EFTO) - Green 
 
Restricted - Light Blue 
 
Confidential - Navy Blue 
 
Secret - Red 
 
Top Secret - Orange 
 
Sensitive Compartmented Information (SCI) - Yellow 

 
Many of the windows have pull-down menus allowing the user to select options or functions to be 
performed.  The CSP operator can make windows into icons to save the windows for future use without 
closing them.  The icons are pictorial representations of the windows.  Almost all of the functions may be 
performed using the standard three-button mouse with minimal reliance on a keyboard.  The left button 
on the mouse is used to select whatever option or function is desired. The middle and right buttons are 
reserved for specialized actions on specific types of objects.  A general use for the right button is to 
provide the classification of a selected window that may be underneath other windows. 
 
The size and location of the windows on the screen may be modified by a user (Slide 2-11).  The Size 
option for windows can be obtained by selecting the window menu button in the upper left corner of the 
window.  The following options allow the CSP operator to manipulate the windows on the screen: 
 

Restore Changes an icon back to a window.  The window is restored to its original size. 
 

Move Allows the window to be repositioned on the screen without changing its size. 
 

Size Allows the window to be resized by dragging the resize handles. 
 

Minimize Changes the window to an icon that is displayed in the icon window.  This 
option is also selectable using the minimize button located in the upper right 
corner of the window. 
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Maximize Expands the window to the size of the full screen.  This option is also selectable 
using the maximize button located in the upper right corner of the window. 

 
Lower Moves the active window to the bottom of the window stack. 

 
Close Removes a window from the display and terminates the application. 

 
A subset of the sizing menu is available for dialogs and is obtained by positioning the pointer to the 
border of a dialog and pressing the right mouse button (Slide 2-12).  Dialogs may be moved, sized, or 
lowered, but they cannot be minimized, maximized, or closed. 
 
Upon exiting or closing a window, a dialog is frequently displayed requesting some type of operator 
response.  A response is required to that dialog before performing any other action within the main 
window.  There are four main types of dialogs used by the CSP (Slide 2-13).  Each type is denoted by the 
symbol located in the upper left corner of the dialog.  A question dialog allows the application to ask the 
user a question and is denoted by a human silhouette with a question mark.  The normal responses are 
Yes, No, and Cancel.  An error dialog, denoted by a small stripe through a stop sign, indicates that a 
software error has been encountered or that invalid data or an invalid command was entered.  A warning 
dialog, denoted by an exclamation point, alerts the user to the fact that the user actions may result in the 
loss of data.  The last type of message dialog is the information dialog.  It is denoted by a large lower 
case 'i' and is used for messages of an informative nature.  It normally contains a single OK push button. 
 
Within the window environment, there are a wide variety of actions that may be used to input or review 
data.  These include scroll bars, menu bars, text fields, check boxes, radio boxes, steppers, lists, and 
scales and are all explained in the Software User's Manual (SUM). 
 
2.2.3  Hardware Configuration.  The CSP is presently executing on the Digital Equipment Corporation 
(DEC) AXP and the SUN Microsystems Sparc and Ultra processors.  These processors all use the off-
the-shelf compatible peripheral equipment.  Due to the portable nature of the CSP, other platforms may 
be added in the future. 
 
2.2.3.1  Minimum Hardware Configuration.  The minimum hardware configuration consists of a 
single processor unit, a boot console, three disk drives (system disk, primary message file, and secondary 
message file), two disks for archiving of messages, a cartridge tape drive for operating system and CSP 
software releases, a CD-ROM for the Operating System software and Operating System patches, a printer 
for messages and operational reports, a communication multiplexer appropriate to the host processor, and 
an X-Window System capable GUI terminal for message processing and system access (Slide 2-14). 
 
2.2.3.2  Maximum Hardware Configuration.  The maximum hardware configuration consists of a 
Central Processing Unit (CPU), a boot console, five disk drives (system disk, primary message file, 
secondary message file, Intercept disk, back-up pack), two disks for archiving of messages, a cartridge 
tape drive for operating system and CSP software releases, a CD-ROM for Operating System software 
and Operating System patches, one or more nine-track tape drives for over-the-counter tape processing, a 
printer for operational reports, three printers for message output, communication multiplexer(s) 
appropriate to the host processor, and X Window System capable GUI terminals for message processing 
and system access (Slide 2-15). 
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2.3  Basic Operations.  The basic operations required to run the CSP system include system ID and 
login, Notices window, help, password, and session exit (Slide 2-16).  The CSP operations are discussed 
in the following paragraphs. 
 
2.3.1  System Identification and Login.  User terminals that have been successfully started with the 
CSP system display the CSP ID dialog on the screen (Slide 2-17).  When the CSP host is ready for user 
logins, an audit in the Operator Notices Window will beep and state "The CSP host is now ready for user 
logins".  Pushing on the Log In push button or pressing <Return> on the keyboard causes the CSP 
System Login dialog to be displayed (Slide 2-18). 
 
The Login dialog contains two single-line text fields labeled "Username" and "Password".  The CSP 
operator enters a user ID in the Username field and password in the Password field to login to the CSP 
system.  Characters entered into the password field are not visible.  The Login dialog is automatically 
removed from the screen whenever the keyboard is not used for 30 seconds.  The following push buttons 
are used to specify the action to be performed: 
 

OK (Default) Sends the username and password to the CSP system for verification. 
 

Clear Clears both the Username and Password fields. 
 

Help Displays help on the dialog. 
 
If a valid username and password is entered, the Login dialog is removed from the screen and the CSP 
Main Menu is displayed (Slide 2-19).  If an invalid username or password is entered, an error dialog is 
displayed (Slide 2-20).  If three consecutive invalid passwords are entered, the user is locked out of the 
system (Slide 2-21).  The user needs to consult the Security Manager to regain access to the CSP.  The 
CSP system only allows a user access to one user terminal at a time (Slide 2-22).  If a user needs to 
change user terminals, exit out of the current CSP session on the user terminal being used and login to a 
different user terminal.  The Help push button displays help on the dialog to the user. 
 
The CSP Login requires each user to have a unique username and password.  The password is only valid 
for 90 days, at which time, the CSP forces a user to change their access password.  Each user is granted a 
unique set of privileges by the CSP System Manager.  These privileges either allow or disallow access to 
each CSP application (Slide 2-23). 
 
2.3.2  Notice Window.  The Operator Notices window is displayed on the System Console (SUN 
systems) and on the first user terminal listed in the system generated configuration file (AXP systems).  
The CSP does not operate without a fully operational auditing function.  Consequently, the CSP system 
does not operate if the Operator Notices window fails to start-up (Slide 2-24). 
 
The Operator Notices window presents significant audit events to the operator in a read-only multiple-
line text area.  Each new audit record is added to the top of the text area and the existing records are 
moved down.  Approximately 600 audit records, depending on the size of each record, are maintained in 
the text area.  Once the maximum number of audit records is reached, the oldest record is removed from 
the text area and replaced with the newest record.  All of the audit records presented in the Operator 
Notices window are also written to the permanent Audit file. 
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Only three types of audit records are sent to the Operator Notices window.  The following is a list of the 
three types of audit records and the results that are displayed: 
 

Info The Audit record is displayed in the text area. 
 

Warning The Audit record is displayed in the text area and is accompanied by an audible 
alarm signal. 

 
Action The Audit record is displayed in either a warning or an error dialog and is 

accompanied by two audible alarm signals. 
 
Alert The Audit record is displayed in a message dialog accompanied by a repeating 

audible alarm.  Operator response is required to clear the audible alarm. 
 
2.3.3  Help.  The Help window is accessed by the use of the Help menu that appears at the far right end 
of every menu bar or by pushing the Help push button contained on dialogs.  The following list shows 
what items the Help menu provides help for (Slide 2-25): 
 

On Application Allows the user to obtain help on the CSP application that owns the 
window from which this option is selected.  The help text displayed is a 
general overview of the purpose of the application and how it is used. 

 
On Window Allows the user to obtain help on how to use the common components of 

windows.  For example, a description of the title bar and how to use it to 
move a window is included in the help text. 

 
On Keys Displays help on how to use the keyboard to edit text, change the 

keyboard focus, and simulate the use of a mouse. 
 

On Help Allows the user to obtain help on using all the capabilities of the help 
facility.  The Help message displayed includes a description of the Help 
menu, context-sensitive help, and Help window. 

 
When a user selects an option from the Help menu, the Help window is displayed (Slide 2-26).  Although 
only one Help window is available for each application, up to five separate help messages can be 
displayed in one Help window. Each help message is displayed in its own multiple-line text area.  Since 
the text areas are enclosed by a paned area, a user can vary the amount of data shown in each help 
message by moving the sashes.  When the Help window is initially displayed, it contains only one pane.  
As additional help is requested, more panes are added to the paned area.  The help text displayed cannot 
be edited. 
 
The Help window contains a File menu, Edit menu, and Help menu.  The only option on the File menu is 
Exit that simply closes the Help window.  On the Edit menu, the only option normally available is 
Search.  However, if a user has been given the system privilege to edit site-specific help, all of the 
standard Edit menu options are available. 
 
Site-specific help is available for most help messages.  It allows a particular CSP site to augment the 
contents of a help message according to its needs.  If site help is provided for a help message, a button 
labeled "Site" is displayed above the help text area.  Push the Site button to display a site-specific help 
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message in the bottom pane of the Help window.  If a user has site help editing privileges, all the 
standard Edit menu options are available, and a push button labeled "Save" is displayed above the site-
specific help text area.  After editing the site-specific help, push the Save button to permanently save the 
new help message.  A CSP operator may also obtain help on certain dialogs.  This is accomplished by 
pushing the Help push button that is located in the bottom right corner of a dialog. 
 
2.3.4  Password.  The Password application is used to change a user password and may be initiated by a 
user or automatically by the system to change a password (Slide 2-27).  A valid password must be 
between 8 and 16 characters in length to include at least one uppercase character, at least one lowercase 
character, at least one numeric character and at least one special character.  Special characters are as 
follows:  ! “ # $ % & , ( ) * + ‘ - . / : ; < = > ? @ [ \ ] ^ , ` _ { | } ~.  The Set Password dialog is displayed 
after selecting the password application from the Security menu or is initiated automatically under the 
following circumstances: 
 

- if it is the first login attempt for a new user account. 
 

- if it immediately follows a password modification through the User Access application. 
 

- when a user's password expires (every 90 days). 
 
To change a user password, enter the current password in the Old Password field, enter the desired new 
password in the New Password field, reenter the desired new password in the Verify Password field, then 
push one of the following three push buttons at the bottom of the Set Password dialog (Slide 2-28): 
 

OK (Default) All data contained in the display is validated.  If errors are encountered 
an error dialog is displayed and the password is not changed.  If no errors are 
encountered, the Set Password dialog is removed and the user password is 
updated. 

 
Cancel All changes are discarded and the Set Password dialog is removed.  If the Set 

Password application was automatically initiated by the system, the CSP Main 
Menu is removed and the CSP Login dialog is displayed.  When the Set 
Password application is initiated by the system, the password has to be 
successfully changed before a user can continue. 

 
Help Displays help on the Set Password dialog. 

 
2.3.5  Session Exit.  The Session menu under the CSP Main Menu contains a single Exit option that 
allows a user to log off the CSP (Slide 2-29).  After selecting the Exit option, a warning dialog is 
displayed that asks the user to verify their intention to exit the current CSP session.  If the user responds 
Yes, the CSP Main Menu is removed from the screen, and the CSP ID dialog is displayed.  If a user 
responds with No, the warning dialog is removed. 
 
All applications on the user terminal need to be closed prior to exiting the CSP system.  A warning dialog 
is displayed prohibiting the exit whenever an application is still active (Slide 2-30). 
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2.3.6  Exercises.  The following are the exercises for section 2.3.1 through section 2.3.5: 
 
       1. Attempt a login into CSP using a valid username and an invalid  password.  Acknowledge the 

dialog. 
 
       2. Attempt a login into CSP using an invalid username and an invalid password.  Acknowledge the 

dialog. 
 
       3. Attempt a login into CSP using a valid username and password. 
 
       4. Select Session/Exit from the CSP Main Menu.  Acknowledge the dialog by selecting Yes. 
 
       5. Login to CSP using a valid username and password. 
 
       6. Select Help/On Applications from the CSP Main Menu. 
 
       7. Select Help/On Help from the CSP Main Menu. 
 
       8. Select Help/On Window from the CSP Main Menu. 
 
       9. Select Help/On Keys from the CSP Main Menu. 
 
       10. Select File/Exit from the Help window. 
 
       11. Change the password from the CSP Main Menu.  Respond to the dialog with appropriate 

information. 
 
       12. Select Session/Exit from the CSP Main Menu.  Respond to the dialog by selecting Yes. 
 
       13. Login into CSP using a valid username and the new password. 
 
       14. Select Session/Exit from the CSP Main Menu.  Respond to the dialog by selecting No. 
 
       15. Select Session/Exit from the CSP Main Menu.  Respond to the dialog by selecting Yes. 
 
2.4  Resource Operations.  Resource Operations discusses database attributes, access, versions, file 
menus, options menus, edit menus, category menus, community menus, and resource contention (Slide 2-
31).  The CSP resource operations are discussed in the following paragraphs. 
 
2.4.1  Database Operations.  The CSP contains 11 databases. Seven of the 11 databases are system 
databases, and 4 of the 11 databases are security databases.  The seven system databases are:  Automatic 
Routing, Destinations, Office Assignments, Plain Language Address, Routing Indicators, Routing Line 
Segregation, and STU III.  The 4 security databases are:  Communication Lines, Information Labels, 
Security Dictionary, User Access.  All 11 databases with the exception of the STU-III database (which 
does not support versioning) are similar in regards to database attributes, access, versions, File menu 
selections, and Options menu selections. 
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The four databases that include a Category menu selection are Plain Language Address, Routing 
Indicators, STU-III and Security Dictionary.  Plain Language Address and Automatic Routing have the 
Edit menu selection and only Routing Indicators has the Community menu selection. 
 
2.4.1.1  Attributes.  The CSP databases are relational databases.  All entries are stored in a fixed record 
structure and are accessed based upon keyed, sorted record fields.  The databases may be modified while 
the system is on-line. All modifications are placed in effect as soon as the database is saved; five of the 
databases, two system and three security, may be scheduled for a Future update. One of the system 
databases, Plain Language Address, may be scheduled for a future update within 96 hours (four days) 
from the time of modification.  The other four may be scheduled for a future update within 24 hours from 
the time of modification (Slide 2-32). 
 
All databases are subject to a system resource check.  This ensures that two operators are not modifying 
the same database and that a database has exclusive access to all related databases  (e.g., the automatic 
routing database needs exclusive access to the Office Assignments database, therefore, both cannot be 
open at the same time for modification).  All databases may be printed. 
 
2.4.1.2  Access.  The CSP databases may be opened for either View or Modify access.  If a database is 
opened for View access, no modifications may be made to the contained information, however, all 
information may be viewed.  If a database is opened for Modify access, information may be added, 
deleted, or modified (Slide 2-33). 
 
2.4.1.3  Versions.  The CSP system maintains Current, Future, Temporary, and Previous versions of each 
database with the exception of the STU-III database.  The Current version is the database currently in use 
on the system.  The Future version is the database scheduled to be updated to the Current version at a 
scheduled time requested by an operator.  The Temporary version is a user controlled working copy of 
the database.  The Previous version is the database that was the Current version prior to a database 
update. 
 
A user may always open the Current, Temporary, or Previous version of a database for View or Modify 
access, providing the database resource is not locked by another user or task.  The Future version is only 
applicable to 5 of the 11 databases in the CSP system.  The 5 Future versions of the databases that may 
be opened are:  Communication Lines, Information Labels, Plain Language Address, Routing Indicators, 
and Security Dictionary (Slide 2-34). 
 
If a database is open for Modify access, it may always be closed to the Current or Temporary version.  If 
the database supports a Future version, the operator may close the database to the Future version.  The 
operator may also opt to discard all applied changes (Slide 2-35). 
 
The ability to open any version of a database and close that database to a different version allows the 
database manager flexibility in database manipulation.  A typical use would be to open the Temporary 
version of a database for modification, make the appropriate changes, and close the database to the 
Current version (Slide 2-36). 
 



CSPM-5.8-TGO-24APR02 
 

 22 

When a database is closed to the Current version, the CSP system handles all aspects of suspending 
message processing to ensure that no database is updated in the middle of processing a message.  The 
following represents a simplified overview of the steps taken when a database is closed to the Current 
version (Slide 2-37): 
 

1) Modified database is saved to the Future version 
 

2) Message processing is suspended 
 

3) Current version of the database is copied to the Previous version 
 

4) Future version of the database is copied to the Current version 
 

5) Message processing is restarted 
 
The following represents a simplified overview of the steps taken when a database is closed to the Future 
version: 
 

1) Modified database is saved to the Future version and starts a timer 
 

2) Waits for the database timer to expire 
 

3) Message processing is suspended 
 

4) Current version of the database is copied to the Previous version 
 

5) Future version of the database is copied to the Current version 
 

6) Message processing is restarted 
 
2.4.1.4  File Menu.  All CSP database windows contain a File menu.  This File menu contains four file 
handling functions.  These file handling options are Open, Close, Print, and Exit. 
 
2.4.1.4.1  Open.  The Open option is the first selection within the File menu and is used to bring an 
existing version of a database into a window (Slide 2-38). This option may also be invoked by pressing 
<Ctrl+O> while a database window is the active window.  Upon selection of the Open option, the Open 
dialog is displayed overlaying the main window (Slide 2-39).  The Open dialog is displayed 
automatically when an application involving manipulation is initiated.  This dialog allows the CSP 
operator to select the required access (e.g., View or Modify), and version (e.g., Current, Future, 
Temporary, or Previous) of the selected database.  These selections are made using the appropriate radio 
boxes on the Open dialog.  Make the appropriate selections on the Open dialog and then select one of the 
following push buttons: 
 

Open (Default) Opens the requested version of the database with the specified access.  
The Open dialog is removed. 

 
Cancel Cancels the open request and closes the Open dialog. 

 
Help Displays the Help dialog for the Open dialog. 
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When an operator requests to open a database, the system performs a series of resource checks to ensure 
that the database is allowed to be opened for the access requested.  If a resource contention is discovered, 
an error dialog is displayed informing the operator which resource is unavailable (Slide 2-40). If no 
resource contention problems are encountered, the database is opened as requested. 
 
If a database update is currently in progress, that database is not able to be opened for View or Modify 
access (Slide 2-41).  If a database, other than the Plain Language Address, is scheduled for a Future 
update and a request is made to open the database, the operator is presented with a warning dialog 
informing the user of the update and the scheduled time for the update (Slide 2-42).  This dialog contains 
the following two push buttons: 
 

OK Aborts the scheduled update, removes the warning dialog, and displays the Open 
dialog.  The operator may now request access to a version of the database. 

 
Cancel (Default) Cancels the Open request and removes the warning dialog. 

 
If the Plain Language Address Database is scheduled for a future update and a request is made to open 
the database for view, the operator is presented with a warning dialog informing the user of the update, 
the scheduled time for the update and the operator is asked whether the update should be postponed until 
after the Plain Language Address Database is exited (Slide 2-42).  This dialog contains the following two 
push buttons. 
 

OK Postpones the scheduled update, removes the warning dialog and displays the 
Plain Language Address Database. 

 
Cancel (Default) Cancels the Open request and removes the warning dialog. 

 
If an operator selects to cancel an update, and the update time is within one minute of the current time, 
the system disallows the cancel request.  If an operator cancels a Future update, the database that was 
scheduled for update is located in the Future version for that database. 
 
2.4.1.4.2  Close.  The Close option is the second selection within the File menu (Slide 2-43).  This option 
may also be invoked by pressing <Ctrl+C> while a database window is the active window.  If the 
database was opened for Modify access, the Close dialog is displayed (Slide 2-44).  This dialog allows 
the operator to select the version of the opened database to be written to (e.g., Current, Future, or 
Temporary) or to discard all changes made since the database was opened.  If the database was opened 
for View access, the operator is returned to the database main window.  Make the appropriate selections 
on the Close dialog and then select one of the following three push buttons: 
 

Close (Default) Closes the open database to the requested version and removes the 
Close dialog.  If Discard Changes was selected, the Discard Changes dialog is 
displayed. 

 
Cancel Cancels the close request and removes the Close dialog. 
 
Help Displays help on the Close dialog. 
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When closing a database, the operator may select one of three possible database versions or opt to 
discard all changes made.  The Current and Temporary options save the database to the requested 
version.  The Future option requires the operator to enter a time for the update to commence.  The Plain 
Language Address database requires the operator to also enter a date.  This time is the system time that 
the update is to occur.  This allows the operator to specify any time within a 24 hour period.  If the date 
field is present, the operator may specify any date and time within a 96 hour (four day) period.  The 
Discard Changes option allows the operator to discard all applied changes.  The Discard Changes dialog 
is displayed where the appropriate action is requested (Slide 2-45 (1 of 2)).  This dialog contains the 
following two push buttons: 
 

OK (Default) Closes the current database without saving any applied changes.  Both 
the Discard Changes and Close dialogs are removed. 

 
Cancel Cancels the Discard Changes selection and removes the Discard Changes dialog. 

 
When closing the STU-III database, the operator is immediately presented with the Save Modification 
dialog (Slide 2-45 (2 of 2)).  This dialog contains the following three push buttons: 
 

Yes (Default) Saves the database and closes the Save modifications dialog and the 
STU-III database display. 

 
No Removes the Save modifications dialog and the STU-III database display without 

saving the modifications. 
 
Cancel Removes the Save modifications dialog and cancels the Save selection, returning 

to the STU-III database display. 
 

NOTE: There is only one version of the STU-III database (i.e., no future, current, previous, or 
temporary). 

 
2.4.1.4.3  Print.  The Print Option is the third selection within the File Menu (Slide 2-46).  This option 
may also be invoked by pressing <Ctrl+P> while a database window is the active window.  Upon 
selection of the Print option, the Print dialog is displayed overlaying the database main window (Slide 2-
47).  This dialog allows the operator to obtain hard copies of the database. 
 
The Print dialog contains a list of the available printer destinations and a scale to specify the number of 
copies to be printed.  Make the appropriate selections and then select one of the following three push 
buttons: 
 

Print (Default)  Prints the number of copies of the active database to the specified 
printer device.  The Print dialog is removed. 

 
Cancel Cancels the Print requests and removes the Print dialog. 

 
Help Displays help on the Print dialog. 

 
2.4.1.4.4  Exit.  The Exit option is the fourth selection within the File Menu (Slide 2-48).  This option 
may also be invoked by pressing <Ctrl+E> while a database window is the active window.  If the 
database was opened for View access or no changes were applied to the database, the database and main 
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window are closed and the application is terminated.  If the database was opened for Modify access and 
changes were applied to the database, the Save dialog is displayed (Slide 2-49).  This dialog allows the 
operator to specify whether the applied changes are to be saved using the following three push buttons: 
 

Yes (Default) Removes the Save Modifications dialog and displays the Close dialog. 
 After making the desired selections on the Close dialog and pushing the Close 
button, the database and main window are closed and the application is 
terminated. 

 
No Closes the database and main window without saving modifications and 

terminates the application. 
 

Cancel Cancels the Exit request and removes the Save Modifications dialog. 
 
If the CSP operator has requested a save of the database changes by selecting Yes on the Save dialog, the 
Close dialog is displayed.  The Close dialog allows the operator to select the version of the opened 
database to be written to (e.g., Current, Future, or Temporary) or to discard all changes made since the 
database was opened.  Make the appropriate selections on the Close dialog and then select one of the 
following three push buttons: 
 

Close (Default) Closes the open database to the requested version and removes the 
Close dialog.  If Discard Changes was selected, the Discard Changes dialog is 
displayed. 

 
Cancel Cancels the close request and removes the Close dialog. 

 
Help Displays help on the Close dialog. 

 
NOTE: There is only one version of the STU-III database (i.e., no future, current, previous, or 

temporary).  The close dialog is not presented if “Yes” is selected from the close dialog.  In this 
case, the STU-III database is closed and the changes are saved immediately. 

 
2.4.1.5  Options Menu.  The Options menu provides functions to assist in maintaining files and 
performing operations on messages.  Each application has its own specific set of options on the Options 
menu. 
 
2.4.1.5.1  Expand.  The Expand option is used to modify or view a record currently in a file (Slide 2-50). 
The Expand option is sensitized only when a single selection has been made from the application list.  
Each application has its own unique Expand dialog and the specific fields and restrictions are discussed 
with each application. 
 
To modify or view a record, select the record from the list in the application main window, then select 
Expand from the Options menu and the Expand dialog is displayed (Slide 2-51).  If the file is open for  
 



CSPM-5.8-TGO-24APR02 
 

 26 

Modify access, the push buttons are Modify, Cancel, and Help.  If the file is open for View access, the 
push buttons are Close and Help.  The expand dialog has the following four possible push buttons: 
 

Modify (Default for Modify)  All data contained in the dialog is validated.  If errors are 
encountered, an error dialog is displayed.  Push the OK push button to 
acknowledge the error.  The error dialog is removed and the errors may be 
corrected.  If no errors are encountered, the Expand dialog is removed. 

 
Cancel Any changes are discarded, and the Expand dialog is removed. 

 
Close (Default for View) The Expand dialog is removed. 

 
Help Displays help on the dialog to the user. 

 
2.4.1.5.2  Append.  The Append option is used to append a new record to a file and is only sensitized 
when a file is open for Modify access (Slide 2-52).  Any selections from the list are ignored when 
Append is chosen.  Append is a valid option regardless of the number of items selected. 
 
To append a new record to a file, select Append from the Options menu and the Append dialog is 
displayed (Slide 2-53).  The fields in the Append dialog are blank except for any default values.  Make 
all desired changes to the dialog and select one of the three following push buttons: 
 

Append (Default) All data contained in the dialog is validated.  If errors are encountered, 
an error dialog is displayed.  Push the OK push button to acknowledge the error. 
The error dialog is removed and the errors may be corrected.  If no errors are 
encountered, the Append dialog is refreshed to its initial state and the new record 
is displayed at the end of the application main list.  Another record may now be 
appended to the file. 

 
Close Any changes entered after the last Append are discarded, and the Append dialog 

is removed.  If the list in the main window is a sorted list, the list is resorted at 
this time. 

 
Help Displays help on the dialog to the user. 

 
2.4.1.5.3  Duplicate.  The Duplicate option is used to make a duplicate of an existing record in a file.  
The Duplicate option is only sensitized when a file is open for Modify access and a single selection has 
been made from the application list (Slide 2-54). 
 
To duplicate a record in a file, select the record to be duplicated from the list and select Duplicate from 
the Options menu, the Duplicate dialog is displayed (Slide 2-55).  The fields in the Duplicate dialog 
contain the values associated with the record selected from the list.  Make all desired changes to the 
dialog and then select one of the following three push buttons: 
 

Duplicate (Default) All data contained in the dialog is validated.  If errors are encountered, 
an error dialog is displayed.  Push the OK push button to acknowledge the error. 
The error dialog is removed and the errors may be corrected.  If no errors are 
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encountered, the Duplicate dialog is refreshed to its initial state and the new 
record is displayed in the application list just preceding the selected record.  The 
selected record may now be duplicated again. 

 
Close Any changes entered after the last Duplicate are discarded, and the Duplicate 

dialog is removed.  If the list in the main window is a sorted list, the list is 
resorted at this time. 

 
Help Displays help on the dialog to the user. 

 
2.4.1.5.4  Delete.  The Delete option is used to remove one or more existing records from a file.  The 
Delete option is only sensitized when a file is open for Modify access and one or more entries have been 
selected from the application list (Slide 2-56). 
 
To delete a record from the file, select the record(s) to be deleted from the list and select Delete from the 
Options menu.  The Delete dialog is displayed with the first record selected in the dialog (Slide 2-57).  
The delete dialog has the following four push buttons: 
 

Delete All All records selected from the application list are deleted from the file and 
removed from the application list.  If errors are encountered, an error dialog is 
displayed.  Push the OK push button to acknowledge the error.  The error dialog 
is removed and the processing continues.  After all selected records are deleted, 
the Delete dialog is removed. 

 
Delete (Default) The record displayed in the Delete dialog is deleted from the file and 

removed from the application list.  If an error is encountered, an error dialog is 
displayed.  If more records remain to be deleted, the next selected record is 
displayed in the Delete dialog.  If no records remain to be deleted, the Delete 
dialog is removed. 

 
Keep The record displayed in the Delete dialog is not deleted and is deselected from 

the application main list.  If more records remain to be deleted, the next selected 
record is displayed in the Delete dialog.  If no records remain to be deleted, the 
Delete dialog is removed. 

 
Close All remaining items selected from the main list are not deleted and are 

deselected from the application main list, and the Delete dialog is removed. 
 
2.4.1.6  Edit.  The Edit menu is used to perform Search and Replace operations on the Plain Language 
Address Database as well as the Automatic Routing Database.  The Replace option is not available if the 
database is opened with view-only access.  Additionally, the Edit menu within the Automatic Routing 
Database includes Undo, Cut, Copy, Paste, Clear and Delete commands. 
 
2.4.1.6.1  Search.  The Search option is used to search the entire Plain Language Address Database for a 
specific substring.  After selecting Search, a dialog is displayed containing a text field labeled “Search 
for:”, and three push buttons labeled “Search”, “Cancel”, and “Help” (Slide 2-61 (1 of 2)). 
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To use the Search dialog, enter the text to be searched for in the text field.  Then click one of the buttons 
at the bottom of the dialog. 
 

Search (Default) Begins the search of the Plain Language Address Database.  The 
search begins at the current location in the Plain Language Address Database, 
searches to the end, and continues from the beginning down to the current 
location.  If the text is not found, a dialog with the message “No items were 
found” will appear.  If the text is found, it will be highlighted within the 
appropriate PLA, AIG, or DAG dialog.  You can keep searching for the same 
text string, or the search text field may be edited to search for something 
different. 

 
Cancel Removes the dialog. 
 
Help Displays help on the dialog. 
 

The Search option found under the Edit menu within the Automatic Routing Database operates in a 
similar manner except that “Close” removes the dialog instead of “Cancel”. 
 
2.4.1.6.2  Replace.  The Replace option is used to search for a string in the Plain Language Address 
Database and replace it with another string.  After selecting Replace, a dialog is displayed containing two 
text fields labeled “Search for:” and “Replace with:”, a toggle button labeled “Replace All”, and four 
push buttons labeled “Search,” “Replace,” “Cancel,” and “Help” (Slide 2-61 (2 of 2)). 
 
To use the Replace dialog, enter the search and replacement text in the appropriate fields.  If the Replace 
All toggle is selected, the Replace push button is labeled Replace All instead of Replace.  To find all 
occurrences of the search text and automatically replace each one with the replacement text, click the 
Replace All button.  Otherwise, click the Search button. 
 

Search (Default) Manually search for text and select each occurrence to replace. 
 
Replace Select each time you want to replace the selected text. 
 
Cancel Removes the dialog. 
 

The Replace option, found under the Edit menu within the Automatic Routing Database, operates in a 
similar manner except that two additional checkboxes are found in the Replace dialog (Whole Word and 
Case Sensitive) and “Close” removes the dialog instead of “Cancel”. 
 
2.4.1.7  Category.  The Category menu is used to designate the type of list to be displayed in the window 
and is utilized within the following databases:  Plain Language Address, Routing Indicator, STU-III and 
Security Dictionary. 
 
2.4.1.7.1  Plain Language Address Category Menu.  The Plain Language Address Category menu 
contains the options of PLAs, AIGs, and DAGs.  The PLAs, AIGs, and DAGs are used by the PLA 
application to convert DD Form 173 input into appropriate GENSER or DSSCS messages (Slide 2-62). 
 
2.4.1.7.1.1  PLA.  The PLA option is used to provide the list of PLAs. 
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2.4.1.7.1.2  AIG.  The AIG option is used to provide the list of Address Indicator Groups (AIGs). 
 
2.4.1.7.1.3  DAG.  The DAG option is used to provide the list of DSSCS Address Groups (DAGs). 
 
2.4.1.7.2  Routing Indicators Category Menu.  The Routing Indicator Category Menu contains the 
options of Local RIs, CARP RIs, Collective RIs, and Special RIs.  Each of these options designates a 
level or type of RI classification (Slide 2-63). 
 
2.4.1.7.2.1  Local RIs.  The Local RI option is used to provide the list of Local RIs. 
 
2.4.1.7.2.2  CARP RIs.  The CARP RI option is used to provide the list of Contingency Alternate 
Routing Program (CARP) RIs. 
 
2.4.1.7.2.3  Collective RIs.  The Collective RI option is used to provide the list of Collective RIs. 
 
2.4.1.7.2.4  Special RIs.  The Special RI option is used to provide the list of Special RIs. 
 
2.4.1.7.3  STU-III Menu.  The STU-III Category menu is used to designate which portions of the 
database are to be viewed or modified.  The Category menu contains the options of Device List and ACL 
Entries (Slide 2-64). 
 
2.4.1.7.3.1  Device List.  The Device List option is used to provide the list of defined STU-III devices. 
AT&T STU-III units and Motorola STU-III units cannot be mixed on a single CSP system.  The list of 
STU-III’s maps each phone to the CommServer port to which they are attached. 
 
2.4.1.7.3.2  ACL Entries.  The ACL Entries option is used to provide the list of defined ACLs.  The 
Access Control List maps each ACL entry to an associated communications line. 
 
2.4.1.7.4  Security Dictionary Category Menu.  The Security Dictionary Category menu contains the 
options of Classifications, Classification Association, Compartments, Codewords, Caveats, TCCs, TCC 
Associations, TRC Associations, SPECATs, LMFs, Handling Instructions, CICs, and Words/Phrases. 
Ten of the categories define a particular type of security element while three provide associations for the 
security element (Slide 2-65). 
 
2.4.1.7.4.1  Classifications.  The Classifications option is used to provide the list of Classifications. 
 
2.4.1.7.4.2  Classification Associations.  The Classification Associations option is used to provide an 
empty list.  Only Option /Expand is available. 
 
2.4.1.7.4.3  Compartments.  The Compartments option is used to provide the list of Compartments. 
 
2.4.1.7.4.4  Codewords.  The Codewords option is used to provide the list of Codewords. 
 
2.4.1.7.4.5  Caveats.  The Caveats option is used to provide the list of Caveats. 
 
2.4.1.7.4.6  TCC.  The TCC option is used to provide the list of Transmission Control Codes (TCCs). 
 
2.4.1.7.4.7  TCC Associations.  The TCC Associations option is used to provide the list of TCCs. 
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2.4.1.7.4.8  TRC Associations.  The TRC Associations option is used to provide an empty Transmission 
Release Code (TRC) Associations list.  Only Option /Expand is available. 
 
2.4.1.7.4.9  SPECAT.  The SPECAT option is used to provide the list of Special Categories (SPECAT). 
 
2.4.1.7.4.10  LMF.  The LMF option is used to provide the list of Language Media Formats (LMF). 
 
2.4.1.7.4.11  Handling Instructions.  The Handling Instructions option is used to provide the list of 
Handling Instructions. 
 
2.4.1.7.4.12  CIC.  The CIC option is used to provide the list of Content Indicator Codes (CIC). 
 
2.4.1.7.4.13  Words/Phrases.  The Words/Phrases option is used to provide the list of Words and 
Phrases. 
 
2.4.1.8  Community.  The Community option is used to designate from which community (GENSER or 
DSSCS) the displayed RI list will be derived from.  The Community menu is utilized as an option for the 
Routing Indicator database (Slide 2-66). 
 
2.4.1.8.1  GENSER.  The GENSER option is used to provide the list of RIs associated with the GENSER 
community. 
 
2.4.1.8.2  DSSCS.  The DSSCS option is used to provide the list of RIs associated with the DSSCS 
community.  
 
2.4.2  Parameter Operations.  The CSP system contains 7 parameter files that contain information used 
to modify the system operating parameters.  The 7 parameter files are: Automatic Routing, 
Communication Lines, Message Database, Message Processing, Precedence Timing, Report Scheduling, 
and Font Characteristics.  All 7 of the parameter applications have a similar structure in regard to 
attributes and access and are updated immediately upon exit.  With the exception of the report scheduler 
parameter application, no version handling is available.  An eighth parameter file, CDAC, is available if 
the system is loaded with the optional software. 
 
2.4.2.1  Attributes.  Upon selecting one of the parameter applications, a user with the proper privileges 
is presented with a dialog requesting whether the user wants to modify the parameters or simply view the 
parameters.  The one exception to this is the Reports Scheduling parameter application.  This application 
requires the user to select the version of the parameters database (Current, Temporary, or Previous) and 
whether the database is to be opened for View or Modify access. 
 
Once inside the appropriate application, the parameters may be changed using scales, push buttons, check 
boxes, radio boxes, list selection, or straight data input. Each application contains a Help option that can 
assist the user with useful information pertaining to the given application.  All parameter applications 
contain a method to cancel or discard applied changes.  This is either by the use of the Exit option 
contained on Parameter windows or the Cancel push button contained on Parameter dialogs.  Selecting 
these options closes the active window/dialog without making any changes to the original parameters 
(Slide 2-58). 
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Both the Communication Lines parameter application and the Report Scheduling parameter application 
require the user to select the particular line or report for which the parameters are to be changed.  Only 
one line or report schedule may be reconfigured at a time. 
 
2.4.2.2  Access.  The CSP parameters may be opened for either View or Modify access (Slide 2-59).  
With the exception of the Report Scheduling parameter application, that is prefaced with the Open 
dialog, access to any of the parameter dialogs is prefaced with a Select Access dialog.  The Select Access 
dialog is only displayed to users who have Modify access privileges.  The users may select the required 
access for each session.  The Access dialog has the following three push buttons: 
 

Modify (Default) Opens the selected Parameter application file for Modify access. 
 

View Opens the selected Parameter application file for View access. 
 

Cancel Cancels the access request and removes the Select Access dialog. 
 
2.4.3  Resource Contention.  The CSP system uses resource management as the method to control 
multiple access to its system databases, parameter files, and devices while protecting against the 
corruption of these objects (Slide 2-60). 
 
Within CSP, each system database, parameter file, and device is equated to a specific resource ID.  The 
CSP system uses these resource IDs to monitor and control access to its resources.  The two basic access 
rules that are followed for accessing the CSP resources are: 
 

1. Many readers and no writers. 
 

2. One writer and no readers. 
 
For example, if user one has the RI database opened for View access, user two may also open the RI 
database for View access, but user two cannot open the RI database for modification.  If user one has the 
RI database opened for Modify access, no other user may open the RI database for View or Modify 
access until user one closes the RI database. 
 
Accessing certain resources has an impact on access to other resources because of the complexity of the 
CSP system.  For example, if read or write access has been granted to any of the resources related to 
system databases or system parameter files, then write access to the resource related to the system disk is 
denied.  Table 2.4.3-1 shows each of the CSP applications and the CSP resources and activities that are 
not allowed to occur simultaneously due to resource contentions. 
 
2.4.4  Exercises.  The following are exercises for section 2.4.1 through section 2.4.3: 
 
      1. Login to the CSP system. 
 
      2. Determine which of the system databases can be scheduled for future updates. 
 
      3. Determine which of the security databases can be scheduled for future updates. 
 



CSPM-5.8-TGO-24APR02 
 

 32 

      4. Identify the six parameter files. 
 
      5. Exit from the CSP Main Menu. 
 

Table 2.4.3-1  Activities Not Allowed Simultaneously 
 

CSP APPLICATION CSP SYSTEM ACTIVITES AND 
RESOURCES 

Msg Review ARM DB (Modify) 
Office DB (Modify) 
Destination DB (Modify) 

Msg Recall Destination DB (Modify) 
Msg Gen Destination DB (Modify) 
MSP Destination DB (Modify) 
  
CL Status Destination DB (Modify) 
MR Status Destination DB (Modify) 
MP Status  
AUTODIN Status  
Comm Line Control Destination DB (Modify) 

Comm Line Sec (Modify) 
Altroute Control Destination DB (Modify) 
Msg Proc Control  
System Shutdown  
Report Generation  
  
ARM DB (View) ARM DB (Modify) 

Destination DB (Modify) 
ARM DB (Modify) Msg Review 

ARM DB (View) 
ARM DB (Modify) 
Office DB (Modify) 
Destination DB (Modify) 
ARM Parm (Modify) 

Office DB (View) Office DB (Modify) 
Destination DB (Modify) 

Office DB (Modify) Msg Review 
ARM DB (Modify) 
Office DB (View) 
Office DB (Modify) 
Destination DB (Modify) 

PLA DB (View) PLA DB (Modify) 
PLA DB (Modify) PLA DB (View) 

PLA DB (Modify) 
OLT 

RI DB (View) RI DB (Modify) 
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Table 2.4.3-1  Activities Not Allowed Simultaneously (Continued) 
 

CSP APPLICATION CSP SYSTEM ACTIVITES AND 
RESOURCES 

RI DB (Modify) RI DB (View) 
RI DB (Modify) 
OLT 

RLS DB (View) RLS DB (Modify) 
Destination DB (Modify) 

RLS DB (Modify) RLS DB (View) 
RLS DB (Modify) 
Destination DB (Modify) 

Dest DB (View) Destination DB (Modify) 
Dest DB (Modify) Active Msgs 

Msg Proc Active 
Destination DB (View) 

ARM Parm (View) ARM Param (Modify) 
ARM Parm (Modify) ARM DB (Modify) 

Destination DB (Modify) 
ARM Parm (View) 
ARM Parm (Modify) 

MSG DB Parm (View) Msg DB Parm (Modify) 
MSG DB Parm (Modify) Msg DB Parm (View) 

Msg DB Parm (Modify) 
Comm Line Parm (View) Destination DB (Modify) 

Comm Line Parm (Modify) 
Comm Line Sec (Modify) 

Comm Line Parm (Modify) Destination DB (Modify) 
Comm Line Parm (View) 
Comm Line Parm (Modify) 
Comm Line Sec (Modify) 

Report Parm (View) Destination DB (Modify) 
Report Parm (Modify) 
Comm Line Sec (Modify) 

Report Parm (Modify) Destination DB (Modify) 
Report Parm (View) 
Report Parm (Modify) 
Comm Line Sec (Modify) 

Msg Proc Parm (View) Msg Proc Parm (Modify) 
Msg Proc Parm (Modify) Msg Proc Parm (View) 

Msg Proc Parm (Modify) 
Prec Parm (View) Prec Parm (Modify) 
Prec Parm (Modify) Prec Parm (View) 

Prec Parm (Modify) 
  
Disk Util  
Tape Util  
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Table 2.4.3-1  Activities Not Allowed Simultaneously (Continued) 

 
CSP APPLICATION CSP SYSTEM ACTIVITES AND 

RESOURCES 
OLT PLA DB (Modify) 

RI DB (Modify) 
  
Password  
User Access (View) User Access (Modify) 
User Access (Modify) Logging In 

User Access (View) 
User Access (Modify) 

Sec Dict (View) Sec Dict (Modify) 
Comm Line Sec (Modify) 
Label Sec (Modify) 

Sec Dict (Modify) Msg Proc Active 
Msg Recall 
Sec Dict (View) 
Sec Dict (Modify) 
Comm Line Sec (View) 
Comm Line Sec (Modify) 
Label Sec (View) 
Label Sec (Modify) 

Comm Line Sec (View) Destination DB (Modify) 
Sec Dict (Modify) 
Comm Line (Modify) 
Label Sec (Modify) 

Comm Line Sec (Modify) Msg Proc Active 
Msg Recall 
Comm Line Control 
Destination DB (Modify) 
Comm Line Parm (View) 
Comm Line Parm (Modify) 
Report Parm (View) 
Report Parm (Modify) 
Sec Dict (View) 
Sec Dict (Modify) 
Comm Line Sec (View) 
Comm Line Sec (Modify) 
Label Sec (View) 
Label Sec (Modify) 

Labels (View) Sec Dict (Modify) 
Comm Line Sec (Modify) 
Label Sec (Modify) 
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Table 2.4.3-1  Activities Not Allowed Simultaneously (Continued) 

 
CSP APPLICATION CSP SYSTEM ACTIVITES AND 

RESOURCES 
Labels (Modify) Msg Proc Active 

Msg Recall 
Sec Dict (View) 
Sec Dict (Modify) 
Comm Line Sec (View) 
Comm Line Sec (Modify) 
Label Sec (View) 
Label Sec (Modify) 

Audit Trail  
STU-III (View) STU-III (Modify) 
STU-III (Modify) STU-III (View) 
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APPENDIX A  STUDENT TRAINING MATERIAL GENERAL OVERVIEW SLIDES 



Introduction

Slide 2-1

• CSP mission, functionality, and subsystems
• Hardware configuration
• Graphical User Interface
• CSP basic operations
• CSP resource operations
• File menu
• Options menu
• Parameter operations



CSP Mission

• Automate activities of a fixed-base SSO TCC and BCC
• Consolidated DSSCS and GENSER message handling
• Tailorable to satisfy Tactical/Mobile communication requirements
• Satisfy DIA Circular 5030.58-M security requirements for an AMPE
• Satisfy DCA Circulars 370-D195-1 and 370-D195-3 for connection to 

AUTODIN
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HOL CSP Functionality

• Primary functions:
- Communications circuit automation
- Message receipt
- DD Form 173/ACP 126 conversion
- Message format validation
- Message security validation
- Automated message routing determination
- Manual dissemination
- Message generation
- Message edit
- Message transmission
- Message recall
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HOL CSP Functionality

• Support functions:
- On-line system configuration control
- System control 
- Status reporting
- On-Line Testing support
- User access privileges
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Subsystems
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Data Bases/ 
Parameters/ 

Reports

DD173

Routes:

Security
Processing

Rcvrs Xmtrs

Host

Sections

User I/F

Message/Event 
Storage

Communications

Storage



Communications Subsystem

Components
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Data Bases/ 
Parameters/ 

Reports

Host

Message 
Storage

Comm Lines 
•  Mode I and II
•  FDMP (DDCMP,HDLC,

TCP/IP)
•  Printer (Spooler)
•  Magnetic Tape
•  Intercept
•  Test

Destinations

Intercept 
Data

Printers

Magnetic Tapes

Test 
Data

• Comm Line Params 
• Security Dictionary 
• Comm Line Security

• Active Messages 
• Events

Backups

Communications
Interface
Devices



Processing Subsystem
Components
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Data Bases/ 
Parameters/ 

Reports

Host

Message 
Storage

Message 
•  Validation 

- Format 
- Security 

•  Auto-Routing 
•  DD 173 Conversion

Destinations

• Security Dictionary 
• Comm Line Security 
• PLAs 
• Auto-Routing 
• Office Symbols 
• PLA Stats

• Active Messages 
• Events

Multi-Processes

Primary/Secondary
Storage

•  ACP 126 to JANAP 128
Conversion



Host Subsystem
Components
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Primary/ 
Secondary 

Storage

Service and 
Dissemination 

Messages

Message 
Destinations

User I/F

Statuses
• Destinations 
• Comm Lines 
• AUTODIN 
• Storage

Other CSP 
Components

User I/F



Host Subsystem 
Components (cont.)
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User I/F

Event Stores
• Auditable Events 

Display

Archives

Load 
Store

Message Stores
• Descriptor
• Supplement
• Text 

Message
Files



Host Subsystem 
Components (cont.)
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Utilities Server
• Disk 
• Tape

User I/F

Backup/Restore 
Init 
Mount 
Dismount

Dequeue

"Bust"

Queue

Destinations

Message Processing
• Service 
• Dissemination 
• Comm Line 
• Validation and Routing 
• Sections



Host Subsystem
Components (cont.)
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User I/F

Section Messages 
• Sections 
• Groups 
• Concatenations 
• Release

GroupsRelease 

Concatenate
Move

Message 
Sections

Message 
Destinations

Concatenated/Released 
Sections



Storage Subsystem
Components
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Primary Secondary

Online

Offline

Archives
• Inactive Messages 
• Events

Disk Library

Message Files
• Active Messages
• Events
• Archive Queues 



User Interface Subsystem
Components

User Terminals:
• X Window System
• OSF/Motif
• Color
• LAN I/F to host
• "Diskless"
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Graphical User Interface

• OSF/Motif standards
• X Window System
• Color coded window security labels

- Unclassified Green
- Unclassified EFTO Green
- Restricted Aqua
- Confidential Blue
- Secret Red
- Top Secret Orange
- SCI Yellow
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Graphical User Interface

• Windows, pull down menus, and icons
• 3-button mouse
• Minimum reliance on keyboard
• Keyboard "hot-keys"
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Minimum Hardware Configuration
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Console

Printer

CPU

Memory

Magnetic 
Tape

Communications 
Multiplexer

Serial Lines

Ethernet

Disks System 

Message Files 

Archives

LAN
User 

Terminal



Maximum Hardware Configuration
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ICPs

Console

Printer

CPU

Memory

Disks

Magnetic 
Tape

Ethernet LAN

Communications 
Multiplexer User 

Terminals



CSP Basic Operations

• System ID and login
• Notices window
• Help
• Password
• Session exit
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System ID
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• Terminal powered on prior to booting 
the CSP system

• System ID automatically displayed
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System Login

• Push the "Log In" push button or press <Return> on the 
keyboard

• Enter User ID in the username field
• Enter User Password in password field
• Push the OK button to enter username and password
• Push the Clear button to reenter username and password
• Push the Help button to display help on the dialog
• Read Notice and Consent Banner
• Press Accept to accept the banner and enter the system
• Press Decline to decline the banner and return to the login 

screen
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System ID and Login Characteristics

• 3 attempts prior to a successful login
• Single workstation access
• Unique username and password
• 90 day expiration on password
• Unique privileges
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Notices Window

• Required for operational CSP
• Approximatly 600 events displayed
• Displays significant audit events:

- Info
- Warning
- Action
- Alert
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Help

• Accessed on main windows via the menu bar
• Accessed on dialogs via the Help push button
• Provides help on:

–CSP application for the current window
–Common components of windows
–Use of the keyboard
–Capabilities of help
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Help Window

• Displays up to 5 separate help messages
• The Help window contains:

–File menu
–Edit menu
–Help menu

• Site help
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Password

• User initiated
• System initiated:

– First successful login to a new user account
– First successful login after user password is 

updated by the Security Manager
– Password expiration (90 days)
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Password Modification

• Enter Old password
• Enter New password
• Verify New password
• Push the OK button to enter new password
• Push the Cancel button to cancel operation
• Push the Help button to display help on the dialog
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Session Exit

• Logs the current user off the user terminal

• All applications must be closed
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Data Base  Operations
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• Data base attributes
• Data base access
• Data base versions
• Data base file menu
• Data base options menu
• Resource contention



Data Base Attributes

• Relational data bases (keyed)
• Updated immediately or scheduled for 

update (5 data bases only)
• Subject to access and contention controls
• Printable
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Data Base Access

• View
- Requests View access
- No modifications may be made

• Modify
- Requests Modify access
- Modifications may be made
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Data Bases Versions - Open

A user can open 1 of 4 versions of a data base with View or Modify 
privileges:

• Currently in 
Use

• For Next 
Update

• User 
Controlled

• Last One Used

Temporary

Future

Previous

Current
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Data Bases Versions - Close

A user can close a data base to 1 of 3 versions:

• For immediate update

• For next update

• User controlled Temporary

Future

Discard
Changes

Current
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Data Bases Versions - Usage

Temporary

Future

Current

Previous

Open

Close

���������������������������������������������

���������������������������������������������

���������������������������������������������

���������������������������������������������

���������������������������������������������

���������������������������������������������

���������������������������������������������

User "opens" from a version for modify and closes to a version
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Data Bases Versions - Example

How CSP handles saving a data base to Current:
1) Saves the currently viewed data base to the Future 

version
2) Suspends message processing
3) Copies the Current version of the data base to the 

Previous version
4) Copies the Future version to the Current version
5) Restarts message processing
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Data Bases Versions - Example

How CSP handles saving a data base to Future:
1) Saves the currently viewed data base to the Future 

version and starts a timer
2) Waits for the timer to expire
3) Suspends message processing
4) Copies the Current version of the data base to the 

Previous version
5) Copies the Future version to the Current version
6) Restarts message processing
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Open

• Displays the Open dialog
• Access privileges
• Version

- Current
- Future (5 data bases only)
- Temporary
- Previous

Slide 2-38 (1 of 2)



Slide 2-38 (2 of 2)



Slide 2-39



Slide 2-40



Slide 2-41



Slide 2-42 (1 of 3)



Slide 2-42 (2 of 3)



Slide 2-42 (3 of 3)



Close

• Displays Close dialog
• Version

–Current
–Future (5 data bases only)

»Enter the system time when update is to 
occur

–Temporary
• Discard changes
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Print

• Displays Print dialog

• Output device

• Number of copies
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Exit

• If no changes were made, the window is closed 
without further action.

• If the changes made are not yet saved, the 
operator is asked if the changes are to be saved.
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Expand

• Expands the currently selected item
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Expand Dialog

• Expand options:
–Modify (modify only)
–Cancel (modify only)
–Close (view only)
–Help
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Append

• Appends new records
• Displays a blank record shell (default 

values are displayed)
• Multiple records may be appended to 

the data base
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Append Dialog

• Append options:
- Append
- Close
- Help
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Duplicate

• Duplicates selected record
• Displays the record structure of the selected record
• Same record may be duplicated multiple times
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Duplicate Dialog

• Duplicates options:
- Duplicate
- Close
- Help

Slide 2-55 (1 of 2)



Slide 2-55 (2 of 2)



Delete

• Deletes one or more records
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Delete Dialog

• Delete options:
–Delete all
–Delete
–Keep
–Close
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Parameter Attributes

• Updated immediately
• No version handling

– (exception:  Report Scheduling)
• Application opens on a dialog

– (exception:  Communication Lines and 
Report Scheduling)
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Parameter Access

• View
- Request for View access
- No modifications may be made

• Modify
- Request for Modify access
- Modifications may be made
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Resource Contention

• Provides required stability for on-line data base 
modifications

• Cannot update a data base that is currently being used
–Directly
–Indirectly
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Resource Contention

Modification 

Blocked
Data Base "A"

Jones

Smith

Doe

Viewing
Viewing

STOP

USERS

Data Base "A"

STOPJones

Smith

Doe

Viewing 
Blocked

Modifying
USERS

ACCESS RULE:  
1 Writer 

 
- OR  - 

 
N Readers

EXAMPLE:
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Resource Contention
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1

2

3

4

5

6

7

AUTODIN

MAXI

2 Reg

3 Reg

44 ARTG

6th Army

NORAD

Processing Subsystem
Comm Line DB

Comm Line Params
Auto-Routing DB

Office Symbol DB

Destinations DB has many "readers"...

Destinations Data Base

The user is unable to modify a data base if 
it is open for read access
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